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[bookmark: _Toc7436830][bookmark: _Toc136005788]Introduction
Kanban Task Manager for SharePoint helps a workgroup cooperate on projects and tasks in SharePoint. The software visualizes the workflow and makes it easy to manage projects. 
The traditional wooden kanban board uses paper cards that tell what and how much should be produced and when it should be done. When managers get such a visual overview of the work process and status, they can quickly reveal bottlenecks and blockers. Less time is spent on trying to sort out how projects are coming along, because everything is visible on the kanban board.
With Kanban Task Manager, you can show tasks from a Tasks list on a kanban board in SharePoint, and when there are multiple Tasks lists in a site you can switch between displaying them on the board. Each Tasks list can have its own settings.
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Working in kanban style with tasks in SharePoint gives you everything on a screen, and on top of that the developers of kalmstrom.com Business Solutions have added many useful features:
Drag and drop tasks within or between phases and lanes 
Filter tasks by project(s), responsible(s) and/or priority/priorities and if enabled also by a custom value
Search of task subjects and body texts
Automatic synchronization of tasks within the workgroup, so everything is always up to date and everyone can see what is happening.
Display of tasks for multiple projects in one kanban board
Possibility to create swim lanes
WIP limits gives a warning when there are too many tasks in a phase or a swim lane
Extra field for a custom parameter
Excel reports that show statistics on tasks management
% completed bar that shows task progress
Priority icons on tasks
Task overdue indicator
Assigned person’s image on the task
Set number of columns per phase
[bookmark: _Hlk37856271]Hours open for each task
Create a Checklist for each task
Display the checklist count on the task cards
Time Logging to keep track of invested time per task
Embed code to add Kanban Task Manager on any SharePoint page
Month view to display open tasks of a specific month.
[bookmark: _Hlk505266858]Timeline views grouped by project, assigned and a custom parameter if that is used.
Grid view to see and edit all the tasks in an Excel-like way
7 Habits view to display open tasks in four quadrants on the basis of importance and urgency.
Burndown view that shows the number of tasks that are open, closed and created on each of the latest 30 days.
My Tasks view shows all tasks assigned to me sorted by priority and also today’s activity.
Multiple view, for a manager overview of multiple kanban boards.
Switch between Tasks lists to display on the kanban board.

All editions of Kanban Task Manager are used in a site. Any new additions of Kanban Task Manager will use the same tasks and settings lists as the first one, no matter which edition it is.
You may very well have several sites with Kanban Task Manager, maybe one for each workgroup. Managers can have access to them all, while the workgroup staff only needs to access their own site. 
Chapter 6 of this manual is intended for all users, while the rest is intended for Kanban Task Manager administrators. 
The images in this manual are taken from an English Office 365 SharePoint installation, mostly with the example data.
[bookmark: _Toc136005789]Editions
Microsoft keeps changing the development frameworks for SharePoint, and we are doing our best to stay on top of it. Therefore, Kanban Task Manager comes in three deployment editions. They are installed in different ways, but they have the same version number and features. 
Any differences in the editions depend on how the different kinds of installation file types behave and are not unique to Kanban Task Manager. 
One subscription is valid for all editions, so you can use any combination of editions you wish.
The client side web part, an SPPKG file, currently only supports SharePoint Online, but it is very easy to install and upgrade so we recommend that you use it when possible. It is intended for embedding in SharePoint pages.
The client-side web part is uploaded to and deployed in the tenant's App catalog, and when that is done, it is available as a web part that can be embedded in modern as well as classic pages. Soon it will also be available for Teams. 
To upgrade the client-side web part, just replace the file in the App catalog and all installations in the tenant will be upgraded automatically.
[bookmark: _Hlk37858630]The sandboxed SharePoint solution, a WSP file, is uploaded to a SharePoint solution gallery and activated there and on each site in the collection where it should be used. 
The sandboxed solution supports SharePoint 2013, 2016, 2019. SharePoint Online is also supported, but sandboxed solutions can only be installed in sites that have the Solutions gallery in the site settings – by default modern Team sites without a Microsoft 365 group and classic Team sites with and without a group. To add the gallery to other sites, refer to https://www.kalmstrom.com/Tips/SharePoint-Online-Course/Allow-Custom-Script-In-SharePoint.htm.  
A site with a sandboxed solution can be saved as a template. That is not possible with the SPPKG and APP edtions. Just remember to upload the Kanban Task Manager WSP file along with the template file when you restore the site template on a newly created site collection. 
The PowerShell edition is most useful when you need to automate the process of installing Kanban Task Manager in multiple sites. This edition comes as a ZIP file that includes a PowerShell script, which must be modified for each organization before it is run. It supports SharePoint 2013, 2016, 2019 and Online.
[bookmark: _Toc136005790]Command Bar
The Kanban Task Manager command bar is the same in all editions and views. It has these parts, from left to right:
[image: ]
A search field and a magnifying glass that both open a filter panel to the left. Refer to section 8.4.  
A plus icon to create a new task, refer to section 6.1.2.
A settings gear that opens the Kanban Task Manager configuration, refer to chapter 5.
An icon to download an Excel report with data on all tasks. 
A view selector, refer to section 6.2.
A global counter (when you have added tasks to Kanban Task Manager). The number to the left of the slash displays how many of the tasks that are open, and the number to the right showns the total number of tasks in the list that is visualized on the kanban board.
A SharePoint list does not work well if it has more than 5000 items, so here you can keep track of the total number of tasks.  
In the Burndown view, the search and plus icons are not active. In the other views all icons are active.


[bookmark: _Toc136005791]Task Forms
Kanban Task Manager has its own task form, but that form also has a button for selection of the standard SharePoint form. Both can be used, and each of the forms has some special characteristics. 
The image below shows an empty Kanban Task Manager form from an installation where all options are used (actions, checklist, time logging, lane and extra field). When fewer options are selected, the form will of course be simpler.
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[bookmark: _Toc354151854][bookmark: _Toc7436831][bookmark: _Toc136005792]Languages
The language of Kanban Task Manager is automatically set to the same as on the SharePoint site. The supported languages are: Danish, Dutch, English, French, German, Italian, Norwegian, Portuguese, Spanish and Swedish. When the SharePoint site has another language, Kanban Task Manager will be in English. 
[bookmark: _Toc136005793]General Requirements
To use Kanban Task Manager, you need to have SharePoint 2013 or above (in-house or hosted) or Office 365 SharePoint Online. The client-side web part edition only supports SharePoint Online.
Supported browsers are Microsoft Edge and the latest versions of Google Chrome and Mozilla Firefox.
[bookmark: _Toc3199573][bookmark: _Toc136005794]Permissions
Standard SharePoint permissions are used for Kanban Task Manager. For the installation process, refer to information for the edition you wish to use.
[bookmark: _Toc136005795]Admins
To manage the Kanban Task Manager settings, you need to have Edit permission on the site where Kanban Task Manager is installed. 
[bookmark: _Toc3199576][bookmark: _Toc136005796]Users
People who should work with tasks must have at least Contribute permission on the SharePoint site where Kanban Task Manager is installed.
[bookmark: _Toc532318105][bookmark: _Toc3199577][bookmark: _Toc136005797]Secure the Settings
If users have the default ‘Edit’ permissions on the Kanban Task Manager site, they can change the settings. If you restrict the permission on the Kanban Task Manager site to ‘Contribute’, users can change the task items, but the Configure button will be hidden to them.
We only recommend this for classic sites, as modern sites do not work well with the classic permission settings.
[bookmark: _Toc3199578][bookmark: _Toc136005798]Visitors
For people who just need to see the task it is sufficient with Read permission on the SharePoint site where Kanban Task Manager is installed. Visitors will not be able to modify or add tasks, but they will be able to review the tasks in both the standard list and on the kanban board.
[bookmark: _Toc7436833][bookmark: _Toc136005799]Synchronization
[bookmark: _Hlk36644765]All instances of Kanban Task Manager in a site belongs to the same installation, and automatic synchronization will take place in the background every 3 seconds. 

Tasks that are modified or added by other users will automatically sync and get updated in Kanban Task Manager. Changes in the settings will be automatically implemented on every refresh of the page. 
[bookmark: _Toc136005800] Parts
Kanban Task Manager consists of the following parts:
The file bundle.js, which contains all the functionality and interactivity of the kanban board. It works a lot like an .exe file that performs things when executed. 
In the sandboxed and the PowerShell solutions this file is visible in the Site assets library of the site where Kanban Task Manager is installed, while the client-side web part stores the bundle.js file in a shared location for the entire tenant.
The hidden KTM Settings list, which can be accessed by typing in the URLdirectly to the list: ../lists/KTM Settings/. The KTM Settings list is created when you first start using Kanban Task Manager.
The KTM Settings list is a generic SharePoint list that contains one item for each Tasks list. That way, you can have different settings for the Tasks lists used in a site. The title of the settings item is the GUID of the Tasks list, and the KeyValue column contains a JSON representation of all settings for that list. 
One or more Tasks list(s). If there is already one or more Tasks list(s) in the site, Kanban Task Manager will show it/them on the kanban board.

If there is no Tasks list in the site, you need to create one when you install the sandboxed solution. Note that Tasks lists are created in the classic experience. The other editions create a Tasks list called "KTM Tasks" on first use if there is no other Tasks list in the site. 
Communication sites are primarily not intended for collaboration, and by default it is not possible to create an app built on the Tasks template. Kanban Task Manager will create a task list named KTM Tasks on first use also in a Communication site, but if you want to create another Tasks list by the “add an app” command in a Communication site, you need to activate Team Collaboration Lists under Site settings >Site Actions.


[bookmark: _Toc136005801][bookmark: _Toc354151857][bookmark: _Toc7436834]Installation
The recommended way to test Kanban Task Manager is to create a new site collection for testing. Once the testing is completed, you should start over by installing Kanban Task Manager in the production site collection. It is also possible to continue with the test installation.
When you start using Kanban Task Manager in your organization, you probably want to have multiple installations for different teams. Be aware that Microsoft recommends use of many sites/site collections instead of very big ones with several levels. SharePoint works best that way, and therefore we recommend that you don't have too many installations of Kanban Task Manager in one site collection. Create new sites instead!
In this manual we will generally not use the word “site collection”. When nothing else is mentioned, the word “site” includes any subsites to the main site.
On the kalmstrom.com website, there are video demonstrations on how to deploy and install the Kanban Task Manager editions: https://www.kalmstrom.com/products/TaskManager/DemonstrationsSP.htm
[bookmark: _Toc136005802][bookmark: _Hlk60245358]WSP Edition
The Kanban Task Manager WSP edition is a sandboxed solution. All kalmstrom.com sandboxed solutions are fully supported both by Microsoft, because they don’t use any server-side code. The kalmstrom.com solutions instead build on client side JavaScript code, which Microsoft supports in all versions of SharePoint from 2013 to Online.
The WSP edition is uploaded as a SharePoint Solution to a site, and it needs to be activated there and on each subsite where it will be used. This can be done manually, as described below, or with a PowerShell script given to Premium subscribers on request.
When Kanban Task Manager is activated in a site, all Tasks lists get a Kanban Task Manager logo on top. The first time you click on that logo in a site, a common, hidden list, “KTM Settings”, will be created for the Tasks lists. In the “KTM Settings” list, each Tasks list’s settings has its own item. This means that you can have different settings for the kanban boards, even if the Tasks lists are in the same site.
[bookmark: _Toc136005803]Requirements
You need to be a site Administrator to install solutions. Having that permission level is very common to delegate outside of the IT team. To activate Kanban Task Manager for a site, the site owner permission level is enough.
[bookmark: _Toc136005804]SharePoint Server
The kalmstrom.com sandboxed solutions are easy to install on all versions of SharePoint Server. The SharePoint Sandboxed Code Services must be activated on the SharePoint server, refer to http://www.kalmstrom.com/FAQ/TaskManager/0004.htm.
[bookmark: _Toc136005805]SharePoint Online
Kanban Task Manager can be installed in modern as well as classic sites, but custom scripts must be allowed during installation and upgrade. This is done in the SharePoint Admin center >Active sites >the sites Details pane >Settings by a Global or SharePoint administrator.
 (If scripting is not enabled, there is no Solutions link under Web Designer Galleries in the Site settings.)
[bookmark: _Toc354151858][bookmark: _Toc7436835][bookmark: _Toc136005806]Install in Site
Download the file KanbanTaskManagerSP.zip from the kalmstrom.com website to any folder on your computer and extract it to get the WSP file. Then follow these steps to add Kanban Task Manager to the site.
Go to the root of the SharePoint site where you want to use Kanban Task Manager and open the Site settings. 
[image: Graphical user interface, text, application

Description automatically generated]Under Web Designer Galleries, select “Solutions”. 
(If you don’t see this option, most likely you don’t have the appropriate permission, or your site does not support sandboxed solutions. If so, please talk to your SharePoint admins about configuring you site for sandboxed solutions, see above, or use another edition of Kanban Task Manager.)
Next step is to upload the .wsp file. Click on ‘Upload Solution’ under the SOLUTIONS tab and browse to the file KanbanTaskManagerSP.wsp on your computer. 
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When the file has been uploaded, you will be shown a dialog where you can activate the solution. 
(Don’t worry if you get a warning message. Kanban Task Manager is intended for moderate modification of data, but the solution will do what you tell it to do, nothing more.)
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Now the Kanban Task Manager feature is available for the site. 
If your SharePoint farm or tenant has many sites where you want to use Kanban Task Manager, you need to do this for each one of them. Premium subscribers have the right to receive a PowerShell script for the installations on request.
[bookmark: _Toc354151859][bookmark: _Toc7436836][bookmark: _Toc136005807]Activate for Site
[image: C:\Users\sonal\Desktop\Sonal-Backup\KTMSP_PPT\2013-screenshots\96.png]When Kanban Task Manager has been installed in the site, you need to activate the feature for the site once more. This must also be done for any subsite where Kanban Task Manager should be used. 
1. Go into the Site settings for the site where you want to activate Kanban Task Manager.
1. Click on  “Manage site features” under Site Actions.
Find the Kanban Task Manager entry in the list of Site Features. Click on the Activate button to activate it. 
Now Kanban Task Manager has been activated.
[image: ]
[bookmark: _Toc136005808]The Tasks List(s)
If there is no list app built on the Tasks template in the site where you have activated Kanban Task Manager, you need to create at least one such list.
When the Kanban Task Manager sandboxed solution is installed in a site, all the site’s Tasks lists get the Kanban Task Manager logotype on top. You can always reach the kanban board from the Tasks list by clicking on that Kanban Task Manager logo. 
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Check the checkbox next to the icon, if you want Kanban Task Manager to show the kanban board and not the Tasks list by default, for example when you refresh the page or leave the settings.
[bookmark: _Toc7436844][bookmark: _Toc136005809]Install on a SharePoint Farm
Users who have on-premises SharePoint 2013 or above can install the Kanban Task Manager sandboxed solution on a SharePoint farm using a PowerShell script. To perform this action, you need to be a SharePoint farm administrator.
In this chapter, we show how Kanban Task Manager is installed on SharePoint 2016 on-premises. However, the commands used to add and deploy the solution will be same for both SharePoint Server 2013 and SharePoint Server 2019.
[bookmark: _Toc7436845][bookmark: _Toc136005810]Manage Farm Solutions
Before you perform the steps to install KanbanTaskManagerSP.wsp, ensure that the solution does not already exist in the SharePoint farm. 
2. Go to the Central Administration site. In the Quick launch, click on ‘System Settings’ and select 'Manage farm solutions' under ‘Farm Management’.
[image: ]
Check if there is a solution named kanbantaskmanagers.wsp. If you do not see the WSP, as in the image below, you can skip this step and jump to 3.2 below.
[image: ]
Retract the solution if it exists and the Deployment Status is ‘Deployed’.
[image: ]
If the Deployment status is ‘Not Deployed’, you can skip this step and move to the next step 4. to remove the WSP.
[image: ]
Once the solution is retracted, the status will be changed to Not Deployed and you can remove the solution.
[image: ]
[bookmark: _Toc7436846][bookmark: _Toc136005811]Add and Install Kanban Task Manager
Go to the SharePoint server and open SharePoint 2016 Management Shell as administrator.
[image: ] 
Follow the steps below:
1. Run the following command to add KanbanTaskManagerSP.wsp on the SharePoint farm: “Add-SPSolution <Your WSP Location>” 
(Replace <Your WSP Location> with the literal path to the WSP file.)
Once the solution is added, a solution ID is created. You will need this ID for the further process.
Get the solution with the ‘Get’ command: “Get-SPSolution <Solution ID> | Select *”
(Replace <Solution ID> with the solution ID that was created when you added the solution.)
Run the following command to deploy KanbanTaskManagerSP.wsp on the SharePoint farm: “Install-SPSolution –Identity <Solution ID> –GACDeployment”
(Replace <Solution ID> with the solution ID that was created when you added the solution.)
[bookmark: _Toc7436847][bookmark: _Toc136005812]Upgrade
Go to the SharePoint server and open the SharePoint Management Shell as administrator. Run the following command to update Kanban Task Manager on the SharePoint farm:
“Update-SPSolution -Identity <WSP Name> -LiteralPath <New WSP Path> -GACDeployment”
(Replace <WSP Name> with the name of the WSP file and <New WSP Path> with the literal path of the new WSP file.) 
[bookmark: _Toc7436848][bookmark: _Toc136005813]Remove
The solution can be removed from the SharePoint farm manually as mentioned above. Another way to remove is by running a PowerShell command. Go to the SharePoint server and open the SharePoint 2016 Management Shell as administrator. 
Run the following command to remove the  solution from the SharePoint farm: “Remove-SPSolution -Identity <WSP name>”
 (Replace <WSP Name> with the name of the WSP file on the SharePoint farm.) 
[bookmark: _Toc136005814]SPPKG Edition
The client-side web part is the latest effort from Microsoft to simplify professional SharePoint development. They did this by incorporating lots of open-source technologies and frameworks. 
There are major benefits to this technique, and it is the one that Microsoft is currently recommending. However, it only works consistently on SharePoint Online. We are currently not supporting this model if you are running your own on-premises servers.
[bookmark: _Hlk38214538]The Kanban Task Manager SPPKG edition is intended for embedding Kanban Task Manager in SharePoint pages. When the file has been deployed in the App catalog, the web part shows up among the other web parts when users edit a modern or classic site page. 
It is very easy to upgrade the SPPKG edition because it is hosted from one location and the JavaScript file is not distributed to each of the sites that use Kanban Task Manager. Once you upload a new SPPKG file, all the sites will have the latest code running. No further action is needed.
[bookmark: _Toc136005815]Deployment  in App Catalog.
The Kanban Task Manager client-side web part edition can be downloaded in compressed format from the kalmstrom.com website and then extracted and uploaded to the organization’s App catalog. After that, they are available to the whole farm or tenant.
Permission to add files to the App Catalog is usually only given to administrators within the IT department, normally the SharePoint admin.
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[bookmark: _Toc136005816]Upload to App Catalog
Use a new or existing App catalog.
1. Select "Apps for SharePoint".
Click on "Upload" and browse to the SPPKG file you have downloaded from kalmstrom.com and extracted.
Now the file has been added to the App catalog.
[bookmark: _Toc136005817]Deploy the SPPKG File
The SPPKG file needs to be deployed before the web part can be used:
1. Check the box to make the solution available in all sites.
Click on ‘Deploy’.
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Should you prefer to deploy the solution to all sites later, that is done with the ‘Deploy’ button under the FILES tab in the App catalog. 
[image: ]
When you click on the ‘Deploy’ button, you there is also an option to stop the solution from being installed in new sites. Use that option if you want to keep the existing installations but not allow new ones.
[bookmark: _Toc136005818]Add to Page
To add Kanban Task Manager to a page, open the page in edit mode. I recommend that you use only one column to avoid horizontal scrolling. 
For a modern page, click on the ‘+’ sign in the centre. Search for Kanban Task Manager if you cannot see the icon.
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In a classic page, you can find Kanban Task Manager under the Web parts >kalmstrom.com.
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Add the web part and publish/save the page. There are no settings to be made for this web part. Instead, the settings are made in the Kanban Task Manager configuration.
[bookmark: _Toc58244999][bookmark: _Toc136005819]PowerShell Edition
[bookmark: _Hlk59878344]The PowerShell edition is by far the most powerful and flexible way to install Kanban Task Manager, especially if you want to automate the process of installing in multiple sites. It comes as a zipped package that includes a PowerShell script, which you modify and run so that Kanban Task Manager gets installed in the way you want. 
The PowerShell method requires that you are somewhat familiar with PowerShell and can understand it well enough to make the necessary modifications. We offer paid support services to make those modifications or enhancements as needed.
[bookmark: _Toc136005820]SharePoint Server
When you install the Kanban Task Manager PowerShell edtion in SharePoint on premises, you must be admin on the site(s) where Kanban Task Manager should be installed.
[bookmark: _Toc136005821]SharePoint Online
For SharePoint Online, the PowerShell script requires that you have the SharePoint Admin role in Office 365. This role is usually not delegated outside of the IT department. 
The PowerShell script enables scripting in the site during the installation. This is not enabled by default on modern Group or Communication sites. The script also creates a Site assets library in the site, if it doesn’t already exist.  
[bookmark: _Toc136005822]Installation Process
Unzip the two files into a folder.
Run the PowerShell Integrated Scripting Environment, ISE, as administrator.
Open the PS1 file in PowerShell ISE.
Edit the first few lines of the code to configure your SharePoint version and the URLs of the sites in which you want to install Kanban Task Manager.
If you want to modify the way the Tasks list is created, modify the SetupTaskListObject function further down in the script. 
Save and run the script. Now the script installs Kanban Task Manager in each site that has been added to the script. 
Depending on your environment, you might get asked several times to login with your SharePoint site credentials. If you have not used the SharePoint PowerShell modules, before you will be asked to confirm that you allow installation of one or two of those Microsoft modules.
(If the script creates problems, contact support@kalmstrom.com to schedule a Teams meeting to resolve the issues.)
Store the sites part of the script, so that you can paste it into the new script when it is time to upgrade Kanban Task Manager!


[bookmark: _Toc136005823]First Time Use
When the Tasks list used with Kanban Task Manager is empty (has no tasks), a welcome dialog with some general info is displayed when you open Kanban Task Manager. Behind it, you can see the kanban board. 
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Now you can either add your own data or create example data for the evaluation. Continue to chapter 4 if you want to create example data and to chapter 5 if you want to add your own data at once.

[bookmark: _Toc7436850][bookmark: _Toc136005824]Example Data
The Kanban Task Manager settings are opened via the settings icon. Here you can either add your own data or create example data for the evaluation. Continue to the next chapter if you want to add your own data at once.
[image: ]
The SharePoint status values are by default used as phases in Kanban Task Manager and these status values are applied even if there are no tasks in the Tasks list. The example data will also have priority values set automatically.
[bookmark: _Toc136005825]Create Example Data
To create example data, open the Example Data tab in the Kanban Task Manager settings and select number of tasks. 
By default, the boxes for project, lane, extra field, time logging and checklist are all checked under the Example Data tab, but you can uncheck all or some of them if you want a simpler installation. Your choices will be reflected in the example data and in the Kanban Task Manager configuration.
When you click OK, Kanban Task Manager starts creating the example tasks. 
[image: ]
[bookmark: _Toc7436851][bookmark: _Toc136005826]Remove Example Data
If you have tried Kanban Task Manager in a test site, you can just remove the whole site. 
However, if you have created Example data and want to use the same Kanban Task Manager installation in production, or if you simply want to start over, you can remove the Example data with the Clean-up button under the Example data tab. 
This removes the example tasks and sets the configuration back to default, but it does not reset the trial period.
When you open Kanban Task Manager after the clean-up, the Get-started dialog will be displayed again, and when you have clicked OK to it you can either add your own data or create new example data.

[bookmark: _Ref449789430][bookmark: _Toc7436852][bookmark: _Toc136005827][bookmark: _Ref354161090]Configuration
The Configuration page can be opened from all views via the settings icon.
In the Configuration page, the admin specifies how the kanban board should work for the current Tasks list and how the visualized tasks should look. Click OK to confirm your selection or Cancel to abort it. 
The image below shows the configuration page as it looks the first time you open it, before you have added settings and tasks and before Kanban Task Manager has been registered. 
The Registration tab will be hidden once Kanban Task Manager has been registered. Premium copies of Kanban Task Manager do not have to be registered, so they have no Registration tab. 
[image: Table

Description automatically generated]
In the continuation, we will show images with example data, and the Tasks list used is called “KTM Tasks”. It has the default column names (= the task Status values, see 5.4 below).
It is possible to add values to some of configuration tabs from within the task form, refer to 6.1.2.2, Error! Reference source not found..
[bookmark: _Toc7436856][bookmark: _Toc136005828]Colors
[bookmark: _Toc7436857]By default, colors in the different Kanban Task Manager views are associated with the assigned person. When you have projects you may instead let each project have its own color. 
Click on the color you want to change, to replace the default assigned/project colors.
[image: Graphical user interface, application
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[bookmark: _Toc7436858][bookmark: _Toc136005829]Checklist
[image: ]To make it easier to work with large tasks, users can add checklists to them. Users can manage each checklist in the task form, while creating or editing a task. This feature is disabled by default.
[bookmark: _Toc7436859][bookmark: _Toc136005830]Time Logging
[image: ]Keep track of how long users have worked on a task with the help of time logging. Users can manage the time logging in the task form, while creating or editing a task. This feature is disabled by default.
Each user enters how many minutes he or she has worked with the task, and the time is automatically added and converted into hours. In the Kanban Task Manager statistics, you can see hours per task, phase and responsible. 
[bookmark: _Toc7436902][bookmark: _Toc136005831][bookmark: _Hlk2702171]Edit or Delete Time Log Entry
If users make mistakes, the time log entry can be edited or deleted in the SharePoint task form. It can also be edited or deleted in the Tasks list associated with Kanban Task Manager.
[bookmark: _Toc136005832]Task Status
The different phases in the work process are by default defined with the SharePoint options for Status: Not Started, In Progress, Waiting on someone else, Deferred and Completed. 
[image: A picture containing graphical user interface
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To edit the default options, click on a phase name and write in your own name instead. You can also add phases here, hide them from the kanban board and set their sequence on the kanban board.
By default, closed tasks are moved automatically to the Completed phase. Under the Status tab you can change that setting, and you can also set the number of columns and allowed number of tasks per phase. 
[bookmark: _Toc7436863][bookmark: _Toc136005833]Columns Per Phase
If the installation has few phases and you use big screens, you can set one or more phases to have more than one column of tasks. This can be done for all phases, and you can have up to 9 columns in a phase. 
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Here, we have set the ‘In Progress’ phase to have three columns.
[image: ]
[bookmark: _Toc136005834]Work in Progress
The Work in progress sets a limit for the allowed number of tasks in the phase. The Work in progress setting is not a hard limit. It does not stop users from creatingnew tasks in or moving existing tasks to the phase when the limit has been reached, but the phase name will be displayed in red, as a warning to indicate that a business rule has been broken.
[bookmark: _Toc7436861][image: ]
[bookmark: _Toc136005835]Project
Under the Project tab, you can enter project names to be selected in the tasks. When projects are finished they can be hidden under this tab, and if you have selected to color code the projects, you can change the colors here. You can also decide in which order the projects should be displayed in the task form dropdowns.
Here, the colors are used for Project.
[image: A picture containing diagram
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[bookmark: _Toc7436865][bookmark: _Toc136005836]Hide Phases or Projects
By checking the Hide option for a phase or project item, you may hide that phase or project from the kanban board, from the filter dropdowns and from all views except the Grid view. It is often suitable to hide the “Completed” phase, which you want to keep for statistics but not display on the kanban board. Finished projects that are no longer active for the workgroup should also be hidden.
As Kanban Task Manager uses standard SharePoint list items, hidden phases and projects cannot be hidden from the dropdowns in the open tasks. Instead, you can add a “Z” in front of the name so that these items show up last in the dropdown list.
[bookmark: _Toc136005837]Assigned To
People are added under the Assigned To tab automatically the first time they create or are assigned a task. 
[image: Graphical user interface, text, application

Description automatically generated]You can add people to the Assigned To tab from within the Kanban Task Manager task form, by clicking on the plus sign to the left of the Assigned To dropdown. You can also use the SharePoint form to start writing and then selecting people.
[image: ]
People can be hidden from the Assigned To dropdown in the Kanban Task Manager task form, the Timeline view and the Doughnuts view. When you remove a person’s SharePoint account, that person is also removed from Kanban Task Manager.
[bookmark: _Toc136005838]Multiple Assigned
When a task is assigned to multiple people, a multiheaded icon is displayed on the card on the kanban board, instead of the photo or the initials of a single assigned. In the Timeline view, such tasks are sorted after the first assigned. By default, multiple assigned is allowed in Tasks lists, but that can be changed in the list settings.
[bookmark: _Toc136005839]Assign External Users
When external sharing is allowed in the site, tasks can be assigned to externa users as soon as they have accepted an invitation to the site.
[bookmark: _Toc7436868][bookmark: _Toc136005840]Lane
You don’t need to use lanes on the kanban board, but if you want to group the tasks in swim lanes, enter at least two lane names under the Lane tab. Add a sequence number to get them in the correct order. 
You may set Work in progress limits on the lanes, in the same way as with the status phases, and you may also hide a lane. 
[image: Table
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[bookmark: _Toc7436869][bookmark: _Toc136005841]Change Column Captions
[bookmark: _Hlk38460824]The captions of the columns “Project”, “Status”, “Assigned To” and “Lane” can be replaced with any other captions that better suit the organization. 
Open the Tasks list(s) you are using with Kanban Task Manager. In the list settings cllick on “Project”, “Status”, “Assigned To” or “Lane” under Columns. In the ‘Edit Column’ page, change the column name and click ‘OK’.
[bookmark: _Toc7436853][bookmark: _Toc136005842]Extra Field
Use the Extra field when you want to create a custom parameter to be added to the kanban cards and task form. When you have added a custom field, users can select values for that parameter in the task form, and the tasks can be filtered by those values. 
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If you don’t use an extra field, it is hidden in the task form.
[image: ]When a custom field is used, its value will be displayed in the bottom left corner of the task card, instead of the Due date. In the Kanban Task Manager example data we have chosen the parameter Directions and the values North, South, East and West, but you can set any caption and values that suit your organization.
In the image to the right, the organization has opted to use the parameter “Customer”.  The value selected in the task is the customer name Chris Amey.
[bookmark: _Toc7436854][bookmark: _Toc136005843]Create or Change Extra Field
Enter any parameter name in the Descrption field under the Extra field tab and enter your values.
If you want to change the name of the custom field, write another name in the Descrption field under the Extra field tab (and change the values if needed). 
[bookmark: _Toc39238747][bookmark: _Toc136005844]Hours
Under the ‘Hours’ tab, you can define the office working days, service hours and the lunch break. On the basis of these settings, Kanban Task Manager will calculate the number of hours a task was open. The boxes for Service hours and Lunch break are checked by default and the default settings are:
Working days – Monday to Friday
Service hours – 8 hours (9:00-17:00)
Lunch break – 1 hour (12:00-13:00)
Note: If the ‘Service hours’ checkbox is unchecked, Kanban Task Manager will consider it as 24 hours.
[image: Graphical user interface, application
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The hours open for a task is calculated from the start date to the end date of a task.
For open tasks, the end date is the task’s current time. For closed tasks, the end date is the task’s last modified time.
Users can see the open hours in the task form. A log will be displayed when the mouse hovers over the indicator. 
The open hours can also be studied in the Excel reports., refer to chapter 7.
[bookmark: _Toc136005845]Actions
An action changes multiple properties of a task at the same time. 
For example, if you add the action “needs research” as shown in the image below, you can specify that is should be assigned to a specific person, placed in a specific lane and postponed for 7 days. When a user then selects the “needs research” action for a task, these three properties will be changed automatically.
[image: A picture containing graphical user interface
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Give the action a name and select or write in the values you want to give the task when the action is selected in the Kanban Task Manager task form. 
As the action will be used for a longer period the due date value cannot be given with a date. Instead, it is given with the number of days from the current day.
When you check the box for Save, the action saves the task and closes the form.
[bookmark: _Toc7436872][bookmark: _Toc136005846]Custom Columns
You can add any custom columns that you wish to the Tasks list. They will be shown in the SharePoint form but not yet in the Kanban Task Manager form. That might come in a later version if so requested.
[bookmark: _Toc7436881][bookmark: _Toc136005847]Embed
Use the client-side web part edition if you want to embed Kanban Task Manager in a modern SharePoint page.
For classic pages, the sandboxed solution and the PowerShell edition has an embed code in the Kanban Task Manager Configuration. Copy the code with Ctrl + C.
[image: Graphical user interface, text, application, email
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To embed Kanban Task Manager in a classic page, follow the steps below:
1. Click on ‘Edit’ on the top right of the SharePoint page where you want to embed the kanban board. The page will open in Edit mode.
Open the INSERT tab and click on ‘Embed Code’.
[image: ]
Paste the Kanban Task Manager embed code in the ‘Embed’ dialog.
Click on ‘Insert’ and save the page.
[bookmark: _Toc354151869][bookmark: _Toc7436884][bookmark: _Toc136005848][bookmark: _Ref166771605]Use Kanban Task Manager
Kanban Task Manager can be customized in various ways, so it is possible that your  installation does not have all options activated. However, here we will describe how the product works when all features are activated and the default tasks list is used without any changes.
Kanban Task Manager has multiple views, but the default view is the kanban board and that is where most users will work.
[bookmark: _Toc7436885][bookmark: _Toc136005849]Kanban View
The kanban board displays the tasks in a Tasks list as cards on a kanban board. The task cards are grouped in phases according to their status. By default all tasks in the list are shown on the board. 
The kanban board may also have different lanes. Click on the lane’s name banner if you want to collapse the lane. Click again to open it.
The task cards can be moved between phases and lanes, see 6.1.1.5 below.
[image: ]

You can use the Ctrl key + the plus or minus key to zoom in and out on the kanban board, just like with any web page. 
[bookmark: _Toc136005850]The Task Card
On the kanban board, the tasks are visualized as cards. Each card is color coded, by either project or assigned, and the colored field has information about progress and a checklist count if that is used. The task name is visible above the colored field, and the task cards also contain some other crucial information.
[bookmark: _Toc7436895][bookmark: _Toc136005851]Priority
When you set the priority of a task to something else than the default Normal, it will have an importance icon. 
High priority tasks have red exclamation marks and low priority tasks have blue downward arrows. Tasks with normal priority do not show any icon. 
	[image: Diagram
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Description automatically generated]


[bookmark: _Toc136005852][image: Graphical user interface

Description automatically generated with medium confidence]Due Date / Extra Paramter
If no extra field is used for Kanban Task Manager, the due date will be displayed in the bottom right corner of the task card, see the images above. When an extra parameter is used, the task’s value for the extra field is displayed instead.
[bookmark: _Toc7436896][bookmark: _Toc136005853]Task Overdue Indicators
When a task is overdue, this will be indicated by a red border. The due date or extra field value on the card is also displayed in red.
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Description automatically generated with medium confidence]
[bookmark: _Toc136005854][bookmark: _Hlk526352575]Assigned 
[image: ]The person that the task has been assigned to is displayed with a photo on the task card. If no photo has been added to the SharePoint account, the image icon will have the responsible person’s initials. 
Tasks that have not yet been assigned, have ‘U’ on the image icon. If multiple assigned is allowed, a multiheaded icon is shown on tasks with multiple assigned people.
[bookmark: _Toc354151875][bookmark: _Toc7436893][bookmark: _Toc136005855]Move Task Cards
To drag a task card, within a phase, from one phase to another or from one lane to another, move the cursor over it. The cursor will transform into a hand, and you can drag the card and drop it in the new place.
You can also move task cards within a phase by using the CTRL key + the left or right arrow key.
If you have a touch screen, you can move the cards with a finger. 
When you move the task card to another phase or lane, the phase/lane info in the task will be changed automatically. 
[bookmark: _Toc7436892][bookmark: _Toc136005856]Open and Edit a Task
Double click on a task card to open the task in edit mode. You can also right click on the task card and select Edit, see the image below.
[bookmark: _Toc136005857]Context Menu and Command Bar
When you right-click on a card on the kanban board, you can manage the task in various ways. Use the Edit command if you want to open the Kanban Task Manager form.
[image: Graphical user interface, text, application, chat or text message
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The same commands except Edit can be found in the Kanban Task Manager task form. The form always open in Edit mode. Use Save to save your changes and close the task form and Cancel to discard them and close the task form.
[image: Graphical user interface, application
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[bookmark: _Toc136005858]Edit in SharePoint Form
When you click on the SharePoint icon, the task will open in the standard SharePoint task form instead of the default Kanban Task Manager form. Here, you can directly upload images from your computer to the task.
[bookmark: _Toc136005859]Copy 
When you copy a task, a new task will open. It will have the same data as the original task, but the % Complete value will be set to 0 %. Make any changes you wish and then save the copy. 
[bookmark: _Toc7436894][bookmark: _Toc136005860]Delete a Task
Tasks that are deleted will be moved to the site recycle bin, where they are usually kept for 30 days, making it easy to restore deleted tasks.
[bookmark: _Toc136005861]Comment
When you add a comment to a task by right clicking on the task card and selecting Comment, a dialog will open where you can enter your comment. It will be added to a comment field in the task description, below any description text (and earlier comments).
[image: Graphical user interface, text, application
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When you click on the comment button in the Kanban Task Manager task form, you can enter your comment directly in the field below the description (and any earlier comments). 
[image: Graphical user interface, text, application
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In both cases, each new comment will have its own comment field in the task description. The person who made the comment and the time it was entered will be added automatically.
[bookmark: _Toc136005862]Actions
When you choose an action, one or more task properties are changed automatically. The action might also save and close the task. If actions are used, you can find them at the bottom of the context menu dropdown and in the Actions dropdown in the Kanban Task Manager task form.
The Kanban Task Manager administrator decides in the Kanban Task Manager settings how the various actions should affect the tasks. If that is done correctly and the actions have suitable names, you don’t as a user need to know exactly which the changes are.
[bookmark: _Toc7436891][bookmark: _Toc136005863]Create a New Task
There are several ways to create a new task:
1. Double-click in an empty space on the kanban board. 
1. Write the subject in the search field and then click on the plus sign to open a task with that subject. 
[image: ]
Click on the plus sign, without entering a subject in the search field. 
In all these cases, the Kanban Task Manager task form will open in edit mode. The image below shows the biggest possible Kanban Task Manager form, when checklist and time logging have been activated by the administrator and a custom parameter (Type), Lanes and Actions are used. The task form in your installation might be considerably simpler if all these optional features are not used.
[image: ] 

You can also create new tasks by entering the subject of the task in the textbox and then pressing CTRL+Enter on your keyboard. This will create the new tasks in the first lane and first phase without opening the task. This way of entering tasks is especially useful in brainstorming mode and allows you to add lots of tasks quickly.
[bookmark: _Toc136005864]% Complete
If you fill out the % Complete, the value will be shown as a line on the task card. 
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Description automatically generated with medium confidence]

In the Kanban Task Manager task form, you can set the completed value by dragging the completed chart. 
[image: A picture containing chart
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When you set a completed value to more than 0 for a new task, the Task Status value will automatically be changed into In Progress, and the task card will be moved to the In Progress phase when you save it. And if you set the % Complete to 100, the value will change to Completed and the card will be moved to the Completed phase.
Note: the automatic changes of Task Status value follows the sequence order set in the Kanban Task Manager Configuration, not the actual values. Therefore these automatic changes should work well even if your status names are changed into something else.
[bookmark: _Toc136005865]Categorizations
To the right in the Kanban Task Manager task form, you can select values for various task parameters.  These values are fetched from the settings.
If you cannot find the value you want to use, you can add that value by clicking on the plus sign to the left of the dropdown. Now the new value will be applied and saved to the settings.
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If you use the SharePoint form, you can add new people by writing the first letters of the asignee name in the Assigned To field. Then SharePoint will suggest names from the user accounts. When you save the task, the new name will be added to the settings and can be selected in the Kanban Task Manager form.
[bookmark: _Toc136005866][bookmark: _Hlk37858716]Hours Open
When you open an existing task, you will see an indicator of how many hours the task has been open in the top right corner. If you hover over it, a log will be displayed. Here, you can also see who created the task.
[image: ]
[bookmark: _Toc136005867]Checklist and Time Logging
Kanban Task Manager has two features that must be enabled in the configuration page before they will work: checklist and time logging. You can have both, none or one of them in your installation.
These features can only be entered in the Kanban Task Manager form, but they will be added to the SharePoint form also. In the SharePoint form, they can only be deleted.
[bookmark: _Toc7436897][bookmark: _Toc136005868]Checklist
[image: ]To make it easier to work with extensive tasks, you can add a checklist to it. You can manage the checklist in the task form, while creating or editing a task. The finished steps are displayed on the task card. 
Write a step in the field and click on the plus sign and a new entry will be added below the field. Check the entry when that part of the task is finished. 
When all entries are checked, the task will be considered closed, and by default it will be automatically moved to the Completed phase.
[image: ] 
[bookmark: _Toc7436901]The steps are connected to the progress bar, so that its value will be changed automatically. If all steps are unchecked when the work has started, the task is automatically moved to the Not Started phase and the progress bar value will be zero.
[bookmark: _Toc136005869]Time Logging
Keep track of how long have you worked on a task with the help of time logging. You can manage the time logging in the task form, while creating or editing a task. 
In the image below, Kate Kalmström has written 30 minutes in the field and clicked on the plus sign. That time is now added, and the default 10 minutes will be displayed again in the field.
When several people work on a task, each of them should add their minutes in the form if the feature is used.
[image: ] 
[bookmark: _Toc136005870][bookmark: _Toc354151880][bookmark: _Toc50208439][bookmark: _Toc141783042][bookmark: _Toc172735948]Additional Views
Apart from the default kanban view, there are several more views where you can study the tasks. Select your preferred view from the View dropdown above the kanban board or other current view. 
At the bottom of the view selector, you can also select another Tasks list to show on the kanban board, if multiple such lists have been created in the site. 
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[bookmark: _Toc7436915][bookmark: _Toc136005871]Month and TimeLine
There are two views that show open tasks during a month: Month and Timeline These views actually show the open tasks for six weeks, where the whole current month is included. The tasks are displayed over time slots from the start date to the due date. The time slots are colored with the color for project or responsible, depending on which option is selected in the settings.
In these views, you can drag one end of the time slot to extend or reduce its length and thereby change the start and due dates. You can also drag and drop the whole task, for example to change project or assigned person.

You can open and edit tasks and create new tasks from the Month and Timeline views. Select another period by clicking on the arrows to the left. 
[bookmark: _Toc136005872]Month
The general Month view gives an overview of all open tasks. All the six weeks are displayed at the same time on the screen, like in a calendar.
[image: ]
[bookmark: _Toc136005873][bookmark: _Toc7436918]Timeline 
There are two default Timeline views, grouped by Assigned To (default) or Project. If your installation uses lanes or an extra field, the tasks can also be grouped by those parameters. 
[image: ]
Tasks for approximately ten days are displayed on the screen. When you scroll down on the mouse, the timeline will move to the left so that more tasks are being shown, up to six weeks. 
The Timeline with the default Assigned To grouping, allows you to drag and drop tasks between assignees easily, which can be very useful when somebody has to take time off etc. 
[bookmark: _Toc7436927][bookmark: _Toc136005874][bookmark: _Hlk2272030][bookmark: _Hlk526352861]7 Habits
The 7 Habits view is inspired by the highly popular book “The 7 Habits of Highly Effective People” by Stephen Covey. The book and the view make it easier for users to understand which tasks are most important and urgent and encourage the users to focus on those tasks first. 
The 7 Habits view displays the open tasks in four quadrants: Urgent-Important, Urgent-Not Important, Not Urgent-Important and Not Urgent-Not Important.
The importance depends on the task’s priority, while the urgency depends on the task’s due date.
Quadrant 1: Urgent-Important
High priority tasks that are overdue or due today, will be displayed in the first quadrant. When a task is moved to this quadrant, the priority will automatically be set to ‘High’. The due date will be set to the current date and the time will be set to 23:59.
Quadrant 2: Urgent-Not Important
Low or normal priority tasks that are overdue or due today, will be displayed in the second quadrant. When a task is moved to this quadrant, the priority will automatically be set to ‘Normal’. The due date will be set to the current date and the time will be set to 23:59.
[image: ]

Quadrant 3: Not Urgent-Important
High priority tasks that are not due today, will be displayed in the third quadrant. When a task is moved to this quadrant, priority will automatically be set to ‘High’. One more day will be added to the due date if it is the current date. If the due date is a later date it will remain unchanged.
Quadrant 4: Not Urgent-Not Important
Low or normal priority tasks that are not due today, will be displayed in the fourth quadrant. When a task is moved to this quadrant, the priority will automatically be set to ‘Normal’ and one more day will be added to the due date if it is the current date. If the due date is a later date, it will remain unchanged.
At the top left corner of the view, you can see the total number of open tasks displayed in the view. In the center of the view, you can see the total number of tasks in each quadrant.
[bookmark: _Toc136005875]Grid
In the grid view, you can see all information about all tasks. Progress is indicated in green, and the columns can be filtered and sorted ascending or descending. Enter filter values in the blank rows on top. 
You can also use this view to copy and paste information about the current task load to other applications.
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[bookmark: _Toc136005876]Burndown
[bookmark: _Hlk38212827]The Burndown view shows how the tasks are managed over the last 30 days. The number of New, Open and/or Closed tasks is indicated on one axis and the time on the other axis. 
In the image below, all three boxes (New, Closed and Open) are checked, so all these tasks are displayed.
[image: ]
Experienced project managers can draw conclusions as to the quality of the work being done from this chart. If a lot of new tasks are being created late in the project cycle that is a warning sign. If the number of open tasks is steadily going down, that is a good sign.
[bookmark: _Toc136005877]Donuts
In the Donuts view, you can see how many tasks there are in each status phase, grouped by Assigned To (default) Project or Lane. If you use a custom parameter, you can group by that parameter also (here Type).
[image: Diagram
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[bookmark: _Toc136005878]My Tasks
In the My Tasks view, each user can see analytics of today’s work. Importance is indicated by red, blue or yellow color.
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Double-click on a task name to open that task. Close a task by checking the box to the left of the task name.
[bookmark: _Toc136005879]Multiple
The Multiple view is intended to give managers an overview over multiple kanban boards in different sites. When you select the Multiple view, you will see an overview of all kanban boards that you have access to.
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The tasks are displayed on the Multiboard as small squares. High and Low importance are marked, and overdue tasks have red borders. When you hover the mouse cursor over a square, the task name, project and due date is shown.
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Tasks cannot be dragged and dropped between the phases or lanes in the Multiple view.
To the right in the Multiple view, you can see when each kanban board was updated, and there is a graphical representation of the number of tasks in each phase and lane
[image: Graphical user interface, application
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[bookmark: _Toc37166464][bookmark: _Toc136005880]Filter and Search Tasks
Click on the Search icon to open the left panel. 
[image: ]
Here you may filter tasks by project(s), assigned and/or priority/priorities. If your installation uses a custom field, you can filter on those values too. In the image below, that field is called Directions.
[image: ]  
To search, write a word or phrase in the search field and press Enter or click on the Search icon. 
Kanban Task Manager will search and show tasks that contain the word or phrase on the kanban board. The rest of the tasks will be hidden. 
This search and filter feature work on all views except the Burndown view.
[bookmark: _Toc37166465][bookmark: _Toc136005881]Copy Current Filter
When you click on ‘Copy current filter’, the URL of the filtered kanban board will be copied. 
You can for example filter the kanban board by responsible to show only tasks that a certain person is responsible for, and send the URL to a manager.
[bookmark: _Toc37166466][bookmark: _Toc136005882]Bookmark Filter
Filtered kanban boards can be bookmarked. Click on ‘Copy current filter’ in the Filters pane and paste the copied URL in your browser’s address field. Press Enter to open the page. Now you can bookmark the filtered kanban board in the same way as you bookmark any web page.
If you for example are working with two projects, you can filter the kanban board for first one of them and then the other one. If you bookmark both, you will have the filtered views for these projects easily at hand.

[bookmark: _Toc136005883][bookmark: _Ref478328024][bookmark: _Toc7436930][bookmark: _Hlk60311003]Statistics
When you click on the statistics icon in the Kanban Task Manager command bar, a CSV file is downloaded to your device. This file type shows the data separated by commas.
To create useful reports from a CSV file, you need to open it in Excel, which is default, or another spreadsheet program. Then you can separate the data into columns in a table and create reports from it.
If you are new to Excel, I recommend our book Excel 2016 from Scratch, https://www.kalmstrom.com/Education/Excel-2016.htm, and the free video demonstrations on kalmstrom.com, https://www.kalmstrom.com/Tips/Excel-2016-Course/. Excel has changed very little, so you can use these resources even if you have another version of Excel.
Below, we will just give a few hints on how you can work with the CSV file in Excel.
[bookmark: _Toc136005884]Distribute Data into Columns
Depending on regional settings, Excel will open the CSV file either like in the image below or with the data distributed into columns. If the data is not distributed automatically, you need to do it manually. 
Select everything under A and click on ‘Text to Columns’ under the Data tab. Delimited and Comma and General data format are default, so you just need to click on Next, Next and then Finish.
[image: Graphical user interface, text, application

Description automatically generated]
Now the data is easier to overview, see the image below. You should save the file in XLSX format before you continue.
[image: Graphical user interface, application, table, Excel

Description automatically generated]
[bookmark: _Toc136005885]Format as Table
When you format the text as a table, you can sort and filter the values and start studying the data from different angles. Select all the columns and click on ‘Format as Table’ under the Home tab. 
Select one of the designs, and a small dialog will open. Make sure that you check the box for ‘My table has headers’ and click on OK. 
[image: Graphical user interface, text, application

Description automatically generated]
[bookmark: _Toc136005886]Create Reports
When the data is in a table, you can create reports and study the data in many different ways with pivottables and charts. These commands are found under the Insert tab. 
Click somewhere in the table, and all data in the table will be used in the reports. Start with the recommended pivottables and charts if you are not an experienced Excel user.
[image: Application

Description automatically generated with medium confidence]
Below is a pivottable and a chart shown as an example. Click in the pivot table or chart to display a pane to the right from where you can add and arrange additional data.
[image: Graphical user interface, text, application

Description automatically generated]  [image: Chart, bar chart

Description automatically generated]
[bookmark: _Toc136005887]Upgrade and Removal
Kanban Task Manager is updated often, to enhance the product and keep up with Microsoft’s SharePoint enhancements, so we have tried to make the upgrade process as smooth and quick as possible. 
[bookmark: _Hlk59879692]You can see all revisions and file numbers at https://www.kalmstrom.com/products/TaskManager/RevisionsSP.htm.
The new version of Kanban Task Manager will find and use all your old tasks and settings.
Premium subscribers will have an e-mail when their uniqie copies of Kanban Task Manager have been updated. Other subscribers can download the new version of Kanban Task Manager from the kalmstrom.com download page, at https://www.kalmstrom.com/products/TaskManager/DownloadSP.htm. 
Below we describe upgrade of the various editions with a new version of the same edition, but if you want to switch to another edition of Kanban Task Manager you can do that. The new edition will use the existing Tasks and settings lists. Just follow the steps to remove the old edition below and then add the new edition instead.
[bookmark: _Toc136005888]Upgrade the Client-Side Web Part
All the tenant’s installations of Kanban Task Manager will be upgraded automatically when you add the new SPPKG file to the app catalog.
1. Download the ZIP file and extract it.
Remove the old Kanban Task Manager SPPKG file from the app catalog.
Upload the new SPPKG file to the app catalog. 
Deploy the SPPKG file.
All Kanban Task Manager installations will now be upgraded automatically.
[bookmark: _Toc136005889]Upgrade the Sandboxed Solution 
To upgrade the Kanban Task Manager sandboxed solution, deactivate and delete the old .wsp file and upload and activate the new file according to the steps below.   
This is the upgrade process:
1. Deactivate Kanban Task Manager on all sites where it is activated.
Deactivate the old KanbanTaskManager.wsp file under Site settings >Solutions.
Delete the old KanbanTaskManager.wsp file.
Upload the new KanbanTaskManager.wsp file to the Solutions gallery.
Activate the new KanbanTaskManager.wsp file for the site collection.
Activate Kanban Task Manager on each site where it is used. 
[bookmark: _Toc58245019][bookmark: _Toc136005890]Upgrade with a PowerShell Script
1. Download the new ZIP file and extract it. 
Modify the script so that it suits your installations. This is quickly done if you have saved the part of the old script that contains the sites where Kanban Task Manager was installed.
Run the script to upgrade the installations in all sites that are included in the script.
[bookmark: _Toc58245020][bookmark: _Toc136005891]Removal
If your organization cancels the Kanban Task Manager subscription, or if you after evaluation find that you will not use the product, it must be removed on all sites. Even if you remove the kanban, the Tasks list used by Kanban Task Manager will still be present.
To remove the Kanban Task Manager client-side web part, remove it from the app catalog and from each site where it has been added.
To remove the Kanban Task Manager sandboxed solution, follow step 1-3 in the instruction in 8.2. above.
To remove Kanban Task Manager with a PowerShell script, run the parts of the script that remove Kanban Task Manager.
[bookmark: _Ref323115093][bookmark: _Toc354151881][bookmark: _Toc7436931][bookmark: _Toc136005892]Registration
[bookmark: _Hlk38461905]You may evaluate Kanban Task Manager without cost and with full functionality for 30 days. 
If you want to continue using Kanban Task Manager after the trial period, you must start a subscription. We supply a Premium plan, which gives a special copy of Kanban Task Manager that does not require registration at all.
However, organizations who select the Standard plan must register their installations of Kanban Task Manager. These subscribers will be given a registration key which allows the organization to continue using Kanban Task Manager for the duration of the subscription. 
To register, open the Kanban Task Manager Cnfiguration and select the Registration tab. Click on the Registration button to open the registration dialog.
[image: ]
Enter an e-mail address with your company domain and the registration key you have received from kalmstrom.com. Then click on ‘Registration’. 
The registration must be done once on every site where Kanban Task Manager is used. 
[bookmark: _Toc354151884]The registration key will continue to work as long as the organization is a kalmstrom.com subscriber. 
[bookmark: _Toc136005893]Registration Check
Kanban Task Manager periodically calls the kalmstrom.com server to check if the product has a valid registration key. Only the e-mail address and a unique identifier of the installation is sent to our server – no private information, no information about the data in the application, no usage history etc. 
If you want to avoid the registration check, or if you are using a closed network, we recommend the Premium subscription plan. This will give your organization a Premium copy of Kanban Task Manager that does not perform any registration check.
[image: ]
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@m’,‘fq’g ask Get started with Kanban Task Manager

The Kanban Task Manager tasks are tagged with information about Status phase, Project and Assigned (+ a custom value if you so wish, If you are eveluating Kanban Task
Manager, you might want to open the settings and create example data.

You can also enter your own Project and Lane values in the Kanban Task Manager settings. I you alrezdy have your values in 2n Excel sheet or anather table, you can copy
the datz from there, and paste it in the corresponding grid in the Configuration page. You can also add the settings directly to the corresponding choice field in the Tasks
list.

In the Configuration page you can configure Kanban Task Manager for the workgroup in meny ways. This is described in detail in the Kanban Task Manager manusl. and |
recommend you to downlaad and study it to get the most out of the solution. 3

Should you have questions, you are welcome to contact the kelmstrom.com support.

Good luck with Kanban Task Manager!

s

‘CEO and Systems Designer
kalmstrom.com Business Solutions
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